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Section A:  Introduction 

Lesson: Overview 

  
    

Manual goal 
This manual is created to help staff with override access to efficiently and successfully locate a 
course and complete an override process for a student. 

Intended audience 
Any staff or faculty member who has been granted (by their college chair or dean) override 
access in Banner. 
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Section B:  Set Up 

Lesson: Overview 

  
    

Your Access 
As a general principle of access, the UTPA data (regardless of who collects or maintains it) will 
be shared among those employees whose work can be done more effectively by knowledge of 
such information. Although UTPA must protect the security and confidentiality of data, the 
procedures allowing access to data must not improperly interfere with the efficient conduct on 
UTPA business. 
 
Access to the Student Information System (SIS) is based on a user’s job role and responsibilities.  
Generally access is inquiry only, with the exception of some self service applications (Web for 
Students and Web for Faculty and Advisors) which permit some update capabilities defined in a 
user’s college, department, and instructional assignments. For those forms that you do have 
update access, your username, and in most cases, the date the form was updated, will be recorded 
when a change is made. 

 

 
 
You’re Responsibility 
By law, certain data is confidential and may not be released without proper authorization. Users 
must adhere to any applicable federal and state laws, UT System regulations, and UTPA policies 
and procedures concerning storage, retention, use release and destruction of data. 
 
Generally, student records are protected by the Family Rights and Privacy Act of 1974 (FERPA). 
Access to these records is restricted to those with an “educational need to know” or those who 
have the express consent of the student. This protection does not expire when a student leaves 
the University. In addition, FERPA allows for certain information to be defined as Directory 
Information. This information may be publicly released, unless the student requests 
nondisclosure through the Office of the Registrar. Directory Information is outlined in the 
current UTPA graduate and undergraduate catalogs. Additionally, UT System Business process 
memorandum (BPM 66) protects the use of social security numbers.   
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Section B:  Set Up 

Lesson: Overview (Continued) 

  
    

 

 
All institutional data, whether maintained in the central database or copied into other data 
systems (e.g. personal computers) remains the property of UTPA. Access to data is not approved 
for use outside of user’s official UTPA responsibility. Data will be used only for legitimate 
University business. Information is not to be distributed beyond a users’ office without 
authorization by the appropriate administrator or supervisor.  Distribution beyond the University 
requires permission of the corresponding data custodians(s). Sensitive information which resides 
on desktop or portable machines should be encrypted or password protected to prevent 
distribution by unauthorized persons. 
 
Users must also protect all UTPA data from unauthorized use, disclosure, alteration, or 
destruction. Users are responsible for the security, privacy and management of data within their 
control. Users are responsible for all transactions occurring under their SIS account. Users are 
not to loan or share their account with anyone. If it is found that a user is loaning or sharing 
the access codes, or has inappropriately updated or accessed information stored on the Student 
Information System, the user is subject to disciplinary action including revocation of SIS 
privileges and/or termination. 
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Section B:  Banner Forms 

Lesson: How to Log in 

  
    

Procedure 
Follow these steps to Log into Banner         
 

Step Action 
1 Access the https://mysis.utpa.edu site 
2 Enter your UTPA username and password 

 
 
You will be directed to the General Menu Page. 

 

   

https://mysis.utpa.edu/
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Section B:  Banner Forms 

Lesson: Banner Main Menu 

  
    

 
Banner Main Menu:       
 

 
 
The Main Menu provides an overview of the menus, forms, jobs, and QuickFlows. You use the 
main menu to navigate through Banner. 

   

   Toolbar 

Title  
Bar 

Go to Field 

Products Links 

Hierarchical 
Menu 

Auto Hint/Status Line 

  My Links  
  Canvas 

  Menu bar 
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Section B:  Banner Forms 

Lesson: Banner Main Menu (Continued) 

  
    

Part description: 
The following chart details the different areas of the main menu. 

Menu Part Description 
Menu bar Offers a variety of options for navigating within Banner. However, from the 

main menu, the options are limited 
Toolbar Set of icons that represent shortcuts for performing common functions from 

the main menu. 
Title bar May display the form’s descriptive name, the 7 character ID name, the 

software version number and the database name. 
Go to Field Access a form if you know the 7 character code of the form you wish to 

access. 
Products Links Access contents of various Banner products directly. 
Hierarchical menu Access forms through the main menu hierarchical tree structure. 
Auto Hint/Status 
Line 

Describes the field where the cursor is located. 
Displays error and processing messages. 
Explains the purpose of the field, what can be done next, or how to access 
another window or form. 

Links Canvas The Change Banner Password link goes to the Oracle Password Change 
Form (GUAPSWD), where you can change your password. 
The Check Banner message link takes you the Banner Message Form 
(GUAMESG), where you can view your messages. A green check mark 
appears next to the link when you initially log in and have pending 
messages, or whenever a new message arrives. The pop-up alert for new 
messages is no longer displayed. 
Personal links enable you to create up to 6 links to favorite URLs or often-
used Banner objects. 
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Section B:  Banner Forms 

Lesson: Toolbar Icons 
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Section B:  Banner Forms 

Lesson: Hierarchical Menu 

  
    

Introduction 
When accessing Forms from the Main Menu they are displayed as a hierarchy. You can expand 
and collapse content by clicking on the folders. 
 
Screen image 

 
 
 

1 Closed Folder Select the closed folder to expand and view items 
contained under it. 

2 Open Folder Select the open folder sign to collapse the menu into 
the original item. 

   

1 
1 
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Section B:  Banner Forms 

Lesson: Accessing Forms 

  
    

The most common ways to access forms are: 

1. Hierarchical menu 
2. Go To field 
3. Options Menu 
4. List of forms accessed during current Banner Session stored in the File Menu. 
5. Site map 

 

• Hierarchical menu 
Access forms using the Hierarchical Tree menu on General Menu form: 

 
 
 
 
 

• Go To field 
Forms can be accessed via the Go To field, if you know the seven-character code you 
wish to access. You can also use the up and down arrow keys in the Go To field to access 
forms you have previously opened during your current Banner session. 
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Section B:  Banner Forms 

Lesson: Accessing Forms (Continued) 

  
    

 

 
• Options Menu 

Most Banner forms list related forms which can be accessed using the Options Menu. 

  
 
 
 
 

• List of forms accessed during current Banner Session stored in the File Menu. 
Banner retains a list of forms accessed in the File Menu. You may quickly access these 
forms by clicking on the File menu and choosing the form from the list. This list is 
refreshed each time you log out and log back into Banner. 
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Section B:  Banner Forms 

Lesson: Accessing Forms (Continued) 

  
    

 

• Site Map 
The site map is accessible by selecting the Site Map from the Main Menu. It will list top-
level menus and one level below them. No fields are listed, just links to various menus 
and forms. 
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Section B:  Banner Forms 

Lesson: Blocks 

  
    

All Banner forms are made up of three components: Blocks, Fields, and Records. 
 
Blocks: 
A block is a section of a form or window that contains related information. If a form or window 
contains more than one block, each block (except the key block) may be enclosed in a beveled 
box. 
 
Types of Blocks 
There are two types of blocks; a Key Block and an Information Block. 
 
 

Part of Form Description 
Key Block Where you typically start on a form. 

Most forms have a Key Block. 
A unique code is entered such as an ID number, term code or document 
number. 
Lets Banner know what piece of information you want to retrieve. 
The rest of the information on the form will refer to the information that 
you enter on the Key Block. 

Information Block Section that contains related information to what was entered in the Key 
Block. 
A line may separate each Information Block on the form. 
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Section B:  Banner Forms 

Lesson: Blocks (Continued) 

  
    

 

 
Screen Image 
 

 
 
 
Navigating blocks 
To naviate in between blocks or tabs, use the Next Block or Previous Block functions. There are 
icons located on the toolbar in a form.  
 
Next Block  (or Ctrl-Page Down)  Previous Block  (or Ctrl-Page Up)  

 
 
 
   

 

 

 
 
 

Key Block 

Information Block 
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Section B:  Banner Forms 

Lesson: Fields 

  
    

Fields 
Fields are labeled space with a block. You can Enter, Query, Change and/or Display specific 
information within a field. 
 

 
 
There is usually more than one field on a form: 
 
Screen Image 

   

Field 

Field 

  Field 

Field 
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Section B:  Banner Forms 

Lesson: Records 

  
    

Records 
A record is a group of fields that make up a logical unit. There may be more than one record in a 
block. 
 
Example: A person record is made up of several fields: ID, Last name, First name, Middle name, 
Birth date, Change indicator, Type. 
 
Screen Image 

 
 
 
Record Counter 
The record counter displays number of records viewed and the number of total records. 
Note: A question mark (?) is the status line signifies that there are more records, but you haven’t 
gotten to the last one, so the computer doesn’t know how many there are yet. 
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Section B:  Banner Forms 

Lesson: Records (Continued) 

  
    

Screen Image 
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Section B:  Banner Forms 

Lesson: Records (Continued) 

  
    

Viewing Records 
Some forms have a scroll bar to view existing records. 
 
 

 
 
Navigating records: You can navigate to different records in 3 ways. 
 
1. Use the Next Record or Previous Record functions located on the toolbar in a form. 

Next Record         Previous Record  

           
 

2. Use the record pull-down menu in the menu bar. 
3. Use the keys on the keyboard to navigate through records. 
 
 
 
   

Function Command 
Next Record Down-arrow 
Previous Record Up-Arrow 
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Section B:  Banner Forms 

Lesson: Auto Hint 

  
    

 
Introduction 
The Auto Hint/Status Line appears at the bottom of the screen. It describes the place where the 
cursor is located. Error messages, processing messages, and keyboard equivalents appear here. 
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Section B:  Banner Forms 

Lesson: Wild Cards 

  
    

 
Searching for items in a database: 
 
A wildcard is a special character that represents one or more other characters. 
Use wildcard symbols % and _ in the search criteria. 
 
• % (percent sign) represents any number of characters 
• _ (underscore) represents one occurrence of a character 
 
Note: ma is used as an example. The wildcard symbols can be used with any combination of 
latter in any order. 
 

To get these results… Enter these criteria… 
All entries that CONTAIN ma %ma% 
All entries that BEGIN with ma ma% 
All entries that END with ma %ma 
All entries that have m as a second 
character 

_m% 
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Section B:  Banner Forms 

Lesson: Dialog and Alert Boxes 

  
    

 
Pop-up boxes are windows that appear on your screen for a specific purpose. All popup boxes 
require that you take action before continuing on the form. 
 
There are two types of Pop-up boxes. 
• Dialog Box 
• Alert Box 
 
A dialog box appears when you must chose from two or more responses. The following is an 
example of a dialog box. 

 
 
 
 
An alert box notifies you of a condition that may impact data. The following is an example of an 
alert box. 
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Section B:  Banner Forms 

Lesson: My Banner 

  
    

 
My Banner appears at the top of the Main Menu. It allows quick access to forms, jobs, menus, 
and QuickFlows that are most important in your daily work. 
 
 
Screen image 

 
 
 
Setting up My Banner 
The following forms are used to create, change or copy My Banner 
 
GUAPMNU- Personal Menu Maintenance: Create and change your personal menu. 
 
GUTPMNU-Personal Menu Maintenance Menu and Copy: Copy your personal menu to or from 
another user. 
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Section C:  Day-to-Day Operations 

Lesson: Finding a Student in Banner 

  
    

 
 

Purpose:  To assist staff members in locating a student in Banner in an efficient and timely 
manner. 
 
A student record can be obtained with almost any form used in the Office of the Registrar. 
There are 3 ways to obtain a student record: 
 

1. Enter the Banner ID in the ID field and press Enter or Tab in the form you are working 
on.  
Example A: 

 
 
Example B: 

 
 
Example C: 

 
 
 
Note:  Remember to insert the appropriate term code if applicable.  

Do not use social security numbers in the ID field.   
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Section C:  Day-to-Day Operations 

Lesson: Finding a Student in Banner 
(Continued) 

  
    

 
2a. Use the pull-down menu in the ID field to access the Option List box. 

            
 
 b. Click on Person Search to access the SOAIDEN form. 
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Section C:  Day-to-Day Operations 

Lesson: Finding a Student in Banner 
(Continued) 

  
    

c. Enter all available student information in the SOAIDEN fields.   
    Remember to use % for incomplete names. (See Wild Cards lessen in Section B) 

         
 
 d. Perform an Execute function. 
     The SOAIDEN form will populate most fields: 

                
 
           e. Place cursor on student ID and pick the student using the Select icon.   
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Section C:  Day-to-Day Operations 

Lesson: Finding a Student in Banner 
(Continued) 

  
    

f. Student Banner ID and name will appear on form. 
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Section C:  Day-to-Day Operations 

Lesson: Finding a Student in Banner 
(Continued) 

  
    

 
3.a.  Enter a name in the Name field on a form and Tab. You can use the wildcard (%) 

options 

 
 
Result: ID and Name Extended Search box will appear 

 
 
b. Enter fields available to reduce search. 
  
 Note: 

- Enter SSN numbers with no hyphens: 111223333 
  

- Enter birth dates in following format: 
  Day-month-Year for example: 01-JAN-1980 
 
C Select the Person Search Detail Icon.  
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Section C:  Day-to-Day Operations 

Lesson: Finding a Student in Banner 
(Continued) 

  
    

 
 
 
d. The Person Search (SOAIDEN). 

   
 
 e. Select the student desired using the Select icon. 
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Section C:  Day-to-Day Operations 

Lesson: Overriding a Prerequisite and/or 
Capacity 

  
    

Procedure 
Follow these steps to override a perquisite for a student   
 

Step Action 
1 Access the SFASRPO (Student Registration Permit-Override) form 

 
2 Enter the Student ID in the ID field and  Tab 
3 Enter current tern in Term field 
4 

Perform a Next Block function  
5 Choose which type of Permit the student needs from the Registration Permit Codes box 

and click on OK 
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Section C:  Day-to-Day Operations 

Lesson: Overriding a Prerequisite and/or 
Capacity (Continued) 

  
    

Procedure, continued 
 

Step Action 
7 Enter the CRN in the CRN field 

The Subject, Course Number, & Section fields will populate with CRN information 

 
(See next lesson for locating a class without a CRN). 

8 
 
 
 

Click the Save Icon 
Look for ‘Transaction Complete’ message on Auto Hint Line and notice the User filed 
has been updated with your Username & Activity Date will populate with current date. 
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Section C:  Day-to-Day Operations 

Lesson: Overriding a Prerequisite and/or 
Capacity (Continued) 

  
   

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Note: 
 
To enter a prerequisite override for a Subject and Course, enter the information on the Subject and 
Course fields and save. 
This will allow a student to enter into any section of the subject and course number you have 
selected. 
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Section C:  Day-to-Day Operations 

Lesson: Locating a Course Without a CRN 

  
    

Procedure 
Follow these steps to finding a course without a CRN 
 

Step Action 
1 Access the Access the SFASRPO (Student Registration Permit-Override) form 
2 Enter the Student ID in the ID field and Tab 
3 Enter the current term in the Term field 
4 Perform a Next Block function 
5 Choose which type of Permit the student needs from the Registration Permit Codes box 

and click on OK 
6 To locate the course, click on the down arrow of the CRN option and choose 

SFQSECM. 

  
 
The SFQSECM page will appear: 

 

Notice the 
Student’s current 
schedule is 
displayed below 



 

35 
 

 

Section C:  Day-to-Day Operations 

Lesson: Locating a Course Without a CRN 
(Continued) 

  
    

 

Procedure, continued 
 

Step Action 
7 Enter a course Subject and/or Course and/or Section 

For Example: 

 
8 

Perform an Execute function.  
 
All courses the fall within the criteria you have selected (if offered) will appear: 

 
 

9 To select the course, make sure your cursor has highlighted the CRN and perform a 
Select function. 

 
 

Use scroll bar to 
view all courses 
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Section C:  Day-to-Day Operations 

Lesson: Locating a Course Without a CRN 
(Continued) 

  
    

 

Procedure, continued 
 

Step Action 
9a The CRN will appear on the SFASRPO form: 

 
10 Click the Save Icon 

Look for ‘Transaction Complete’ message on Auto Hint Line and notice the User filed 
has been updated with your Username. 
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Section C:  Day-to-Day Operations 

Lesson: Removing an Permit Override 

  
    

Procedure 
Follow these steps to remove a permit override      
 

Step Action 
1 Access the SFASRPO (Student Registration Permit-Override) form 
2 Enter Student ID and term in ID and Term fields 
3 Perform a Next Block function 
4 Choose the Permit you’d like to remove 
5 From the Record Menu, choose Remove 

 
 

The Permit Code will be removed 
6 Click the Save Icon 
7 The Transaction Complete message will appear on the Auto Hint line. 

*This will not remove a student from a course if they have already registered. 
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Section D:  Contact Information 

Lesson: Helpful Contacts 
  

    
Office of the Registrar        381-2201 
  
Melinda Espinoza 
System Analyst III 
melinda@utpa.edu         316-7158 
 
 
Linda A. Mares 
Business Analyst          
lamares@utpa.edu         381-2388 
 
 
Debora McMillin 
Administrative Coordinator 
deleondy@utpa.edu         318-5356 
 
 
Roy Munoz 
Computer User Service Specialist 
munoz@utpa.edu         316-7933 
 
 
Joni Thomas 
Assistant Registrar for Registration         
tomasj@utpa.edu         318-5355 
 
For technical assistance, please contact 
UTPA Helpdesk 
helpdesk@utpa.edu         381-2020 
 
 
   

mailto:melinda@utpa.edu
mailto:lamares@utpa.edu
mailto:deleondy@utpa.edu
mailto:munoz@utpa.edu
mailto:tomasj@utpa.edu
mailto:helpdesk@utpa.edu
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   Release Date 

  
    

 
V1.0 
This manual was last updated on 03/29/2008 
 
 


